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ВВЕДЕНИЕ 

Поздравляем, дорогой друг, Вы изучили ранее неизвестное 

строение кристалла химического соединения и у вас на руках име-

ется заветный .cif файл! Настало время описать структуру этого со-

единения, задепонировать ее в международном банке структурных 

данных, опубликовать ее в научной работе, провести ее кристалло-

химический анализ в контексте ранее изученных родственных со-

единений с целью выявления фундаментальных закономерностей 

строения твердых тел. Ведь все это необходимо для того, чтобы 

Ваши труды не прошли напрасно, чтобы про них узнала мировая 

научная общественность и сведения о новом кристалле навечно 

вошли в историю, способствуя общему развитию знаний человека 

о природе. Но как это сделать? Это целый мир довольно сложных, 

узкоспециализированных понятий, методов, компьютерных про-

грамм, которые требуют хорошего пространственного воображе-

ния, усидчивости и внимательности от исследователя. Но, как 

говорится, тяжело в учении – легко в бою! 

Данное учебное пособие было подготовлено с целью облегче-

ния прохождения первого пути исследователя от получения нового 

.cif файла до итоговой публикации новой кристаллической струк-

туры в научной статье, дипломной или курсовой работе, тезисах 

сборника докладов на конференции и др. При этом подразумева-

ется, что читатель ранее уже овладел базовым курсом «Кристалло-

химии» и знаком с общими понятиями этой красивой науки. 

В данном учебном пособии основные понятия кристаллохимии 

вспоминаются без подробного их разъяснения. 

Учебное пособие состоит из трех глав. Первая глава посвящена 

самому .cif файлу, его структуре и правилам составления, способам 

работы с ним, средствам проверки его правильности и необходимо-

сти его депонирования. Вторая глава посвящена основным подхо-

дам к описанию кристаллических структур различных типов 
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в научных работах, а также основным кристаллохимическим поня-

тиям, которые помогают описывать строение кристаллов. Третья 

глава посвящена обзору наиболее популярных компьютерных про-

грамм для работы с кристаллоструктурной информацией с обсуж-

дением ключевых особенностей каждой из них. 

Мы искренне надеемся, что, освоив данное учебное пособие, 

описание строения кристаллов для Вас станет несложной и захва-

тывающей процедурой, и что Ваше имя войдет в историю как соав-

тора множества новых кристаллических структур! 

 

Авторы 
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ГЛАВА 1. ЗНАКОМСТВО С .CIF ФАЙЛОМ 

Что такое .cif файл? 

Чтобы ответить на вопрос «Что такое .cif файл?», сначала об-

ратимся к такому понятию, как «язык разметки текста». Языком 

разметки текста в компьютерной терминологии называется набор 

символов или последовательностей символов, вставляемых в текст 

для передачи информации о его отображении или строении. Тексто-

вый документ, написанный с использованием языка разметки, со-

держит не только сам текст (как последовательность слов и знаков 

препинания), но и дополнительную информацию о различных его 

участках – например, указание на заголовки, выделения, списки 

и т.д. В более сложных случаях язык разметки позволяет вставлять 

в документ интерактивные элементы и содержание других доку-

ментов. 

Одним из наиболее известных примеров является «расширяе-

мый язык разметки» (Extensible Markup Language или сокращенно 

XML) – это язык разметки и формат файлов для хранения, передачи 

и восстановления произвольных данных. Он определяет набор пра-

вил для кодирования документов в формате, который является од-

новременно читаемым человеком и машиной. Например, ниже 

представлен XML код для электронной записки, из которого отчет-

ливо видна как сама суть записки, необходимая для человека, так и 

структура языка разметки, необходимая для автоматической обра-

ботки записки машиной: 

<pre><note> 

<to>ANTON</to> 

<from>MAXIM</from> 

<heading>Reminder</heading> 

<body>Meeting at 10 am</body> 

</note> 

</pre> 
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Теперь вернемся к .cif файлу. Аббревиатура CIF используется 

для обозначения сразу двух понятий. Более узкое понятие происхо-

дит от английского ‘Crystallographic Information File’, что в пере-

воде на русский язык означает «файл кристаллографической 

информации». Crystallographic Information File – это стандартный 

формат текстового файла для представления кристаллографической 

информации. Соответствующий компьютерный файл имеет расши-

рение .cif и называется «.cif файлом». По сути Crystallographic 

Information File является языком разметки текста для удобной  

работы с кристаллографической информацией, представляя ее  

в виде, способствующем легкому восприятию как человеком, так и 

машиной. 

Crystallographic Information File был разработан Международ-

ным союзом кристаллографии (International Union of Crystallography 

или сокращенно IUCr). Формат файла был первоначально опубли-

кован Холлом, Алленом и Брауном в 1991 году [1] и с тех пор неод-

нократно перерабатывался (последние версии – 1.1 и 2.0 [2]). 

Полные спецификации формата доступны на веб-сайте IUCr 

https://www.iucr.org/resources/cif. Эта часть веб-сайта IUCr предо-

ставляет обширную документацию и ресурсы для пользователей и 

разработчиков компьютерного программного обеспечения в обла-

сти кристаллографии. Многие компьютерные программы для моле-

кулярного просмотра совместимы с этим форматом, включая Topos, 

Mercury, CrystalMaker, Vesta и Jmol, некоторые из которых рассмот-

рены подробнее в главе 3. 

В более широком смысле аббревиатура CIF расшифровывается 

как ‘Crystallographic Information Framework’ (в переводе «структура 

кристаллографической информации») – это система протоколов  

обмена кристаллографической информацией, основанных на  

определенных словарях данных и правилах соотнесений,  

https://www.iucr.org/resources/cif
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выражаемая в различных машиночитаемых проявлениях, включая, 

Crystallographic Information File и XML. 

На сегодняшний день CIF является стандартной файловой 

структурой для архивирования и распространения кристаллографи-

ческой информации. В настоящее время он хорошо зарекомендовал 

себя и повсеместно используется при определении, публикации и 

депонировании кристаллических структур. Его часто называют об-

разцовым примером интеграции данных и текстовой информации 

для научного общения, ориентированного на данные. В 2006 году 

важность CIF и ценность сопутствующего веб-сервиса для про-

верки структурных данных checkCIF были признаны Премией за из-

дательские инновации Ассоциации издателей научного и 

профессионального общества (Association of Learned and 

Professional Society Publishers или сокращенно ALPSP). В своем от-

чете судьи были впечатлены тем, насколько легко доступны CIF и 

checkCIF (средство для проверки .cif файлов, обсуждается в следу-

ющих параграфах), и тем, что они помогли сделать критически важ-

ные кристаллографические данные более надежными и 

доступными на всех этапах информационной цепочки, от авторов, 

рецензентов и редакторов до читателей и исследователей. При этом 

система освобождает от основной работы по обеспечению досто-

верности результатов научных исследований, не умаляя при этом 

ценности человеческого суждения в процессе исследования и пуб-

ликации. 

В результате чего и как создается .cif файл? 

Структура кристалла определяется в ходе проведения экспери-

мента на монокристалльном рентгеновском дифрактометре. Моно-

кристалл изучаемого соединения помещается в прибор и 

фиксируется дифракция рентгеновского излучения, прошедшего 

через кристалл. Результатом такого эксперимента является набор 
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нескольких тысяч или десятков тысяч отражений (пятен) с различ-

ной яркостью при разных значениях миллеровских индексов (hkl) 

(рис. 1). 

 

 

Рис. 1. Пример дифракционной картины кристалла 

вдоль поворотной оси шестого порядка 

 

Значения миллеровских индексов (h, k, l) для отражений вместе 

со значениями их интенсивностей (F) и стандартных отклонений 

(σ(F)) представляют собой .hkl файл такого вида, где одна строка 

отвечает одному отражению: 

 

 h k l F σ(F) 

 -1 0 0 3200.28 220.28 

 -1 2 0 8450.75 531.75 

 -7 -4 1 424.56 60.79 

 ... ... ... ... ... 

 

По такому набору экспериментальных данных при помощи 

специальных алгоритмов можно восстановить структуру кристалла, 
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которая привела к образованию зарегистрированной дифракцион-

ной картины. Т.е. в результате рентгеноструктурного анализа опре-

деляется вся базовая кристаллоструктурная информация 

(пространственная группа, параметры ячейки, координаты базис-

ных атомов) и дополнительная, такая как огранка кристалла, его 

размеры, цвет, параметры уточнения структуры и прочее. 

На сегодняшний день большинство стандартных компьютер-

ных программных пакетов для решения кристаллических структур, 

которые чаще всего поставляются вместе с экспериментальным 

оборудованием, позволяют выводить результаты именно в формате 

CIF. Например, если для решения структуры кристалла и ее уточне-

ния используется компьютерная программа SHELX [3, 4], являю-

щаяся одной из самых популярных, то для начала работы 

потребуются экспериментальный .hkl файл, а также .ins файл, со-

держащий вводную информацию для компьютерной программы 

SHELX. В результате на выходе получится .cif файл, который со-

держит в себе всю необходимую информацию о структуре кри-

сталла и ее уточнении, а также данные .res файла, который является 

выходным файлом компьютерной программы SHELX, и данные 

.hkl файла для архивирования и возможности обращения к экспери-

ментальным данным в дальнейшем. Кроме того, .cif файл может со-

держать дополнительную информацию о кристалле, такую как его 

форма, цвет, сведения о кристаллографе, проводившем экспери-

мент и др. Часть этой информации может быть введена специали-

стом, проводившим рентгеноструктурный анализ. Всю 

дополнительную информацию можно добавлять в .cif файл впо-

следствии без использования специализированных компьютерных 

программ, например, в стандартных текстовых редакторах. В целом 

в .cif файле можно даже целиком оформить научную статью, посвя-

щенную одной или нескольким кристаллическим структурам. 
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Структура .cif файла и основные метки 

Структура .cif файла такова, что в начале строки в файле при-

водится «имя данных», т.е. определенная команда (компьютерный 

код разметки текста) для считывания машиной (будем называть та-

кие команды «метками»), а после этого следует «значение данных», 

т.е. результат считывания машиной или значение для считывания 

человеком. Один .cif файл может содержать информацию об одной 

или нескольких кристаллических структурах, при этом блок данных 

о каждой кристаллической структуре начинается с команды data_. 

Метки, определяющие тип последующих данных, начинаются 

с символа подчеркивания «_». Любая метка, начинающаяся с под-

черкивания, может играть роль имени данных и разрешена в .cif 

файле. Однако некоторый набор меток был определен как имеющий 

точное значение. Этот набор представляет собой так называемый 

«словарь CIF», который в полном объеме доступен по ссылке 

https://www.iucr.org/resources/cif/dictionaries/search. Значения основ-

ных меток, необходимых обучающимся для подготовки научных 

работ, посвященных описанию новых кристаллических структур, 

объяснены ниже на примере одного из действительных .cif файлов. 

Метки могут возникнуть в двух контекстах. 

(а) Отдельные значения данных: если с элементом данных свя-

зано одно значение, это значение следует сразу за меткой. Напри-

мер, 

 

_cell_length_a 5.959(1) 

 
 

 

(б) Несколько значений данных: в случае таблицы данных, в 

которой имеется множество значений для одного элемента (напри-

мер, набор координат атомов), соответствующие метки собираются 

вместе в группе, предваряемой командой ‘loop_’, что в переводе 

метка значение 

https://www.iucr.org/resources/cif/dictionaries/search
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означает «цикл». При этом ассоциированные значения должны сле-

довать в строгом порядке, соответствующем меткам. Например, 

loop_ 

_atom_site_label 

_atom_site_fract_x 

_atom_site_fract_y 

_atom_site_fract_z 

О1 .4254(4) .5699(1) .3026(1) 

C2 .5630(5) .5087(2) .3246(1) 

Таким образом, каждая метка связана с одним или несколькими 

(в случае цикла) значениями. Значение может быть числовым или 

представлять из себя короткую строку из символов или фрагмент 

текста. Если в качестве значения метки выступает значение физиче-

ской величины, то ее размерность не указывается, т.к. она интегри-

рована в метку. Строки в CIF не должны быть длиннее 80 символов 

– это требование было введено для обеспечения наибольшей совме-

стимости различных компьютерных программ и систем. Абзацы в 

длинных текстовых полях рекомендуется разделять пустой строкой 

для более удобного восприятия информации человеком. Обычно в 

словаре CIF указывается, какой тип данных ожидается для любой 

стандартной метки. Если метка указана, но соответствующее значе-

ние не определено, это отражается символом знака вопроса (?). 

Символ точки (.) в качестве значения данных для определенных ме-

ток означает значение по умолчанию, например, код симметрии по 

умолчанию. Важно помнить, что значение данных может включать 

пробелы только если оно окружено соответствующими кавычками 

(’), двойными кавычками (") или точкой с запятой в начале первой 

строки и в начале последующей строки (;). Например, 

_diffrn_radiation_source ’X-ray tube’ 

значения в цикле 

метки в цикле 

команда начала цикла 
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Также отметим, что для различных специальных символов су-

ществуют специальные обозначения для использования в .cif фай-

лах. В частности, буквы греческого алфавита обозначаются 

соответствующей буквой латинского алфавита с префиксом в виде 

символа обратной косой черты. Например, символы \a, \f, \l, \s и \w 

обозначают соответственно буквы α, φ, λ, σ и ω греческого алфа-

вита. 

Комментарии, которые игнорируются при чтении машиной,  

в .cif файл можно вставлять при помощи символа # в начале строки. 

Таким образом можно производить дополнительную разметку .cif 

файла для более удобного восприятия человеком, например, добав-

лять заголовки разделов или приводить заголовки столбцов при 

отображении данных в циклах (_loop). 

 

Пример .cif файла 

Размер .cif файла может легко превышать 1000 стандартных 

страниц формата А4. Большая часть строк при этом относится к ис-

ходным экспериментальным данным, которые также входят в со-

став .cif файла с целью обеспечения возможности проверки 

правильности определения структуры и ее переуточнения в даль-

нейшем (данные .res и .hkl файлов). Та же начальная часть .cif 

файла, которая может потребоваться для ручного анализа челове-

ком, в зависимости от сложности структуры и количества введен-

ных данных в большинстве случаев занимает примерно от 5 до 50 

стандартных страниц формата А4. Начиная со следующей стра-

ницы, в альбомной ориентации приведен пример .cif файла одного 

из координационных соединений (с пометкой «пример .cif файла с 

пояснениями» на полях). В этом примере оставлены только наибо-

лее важные строки, которые чаще всего требуются при подготовке 

научных работ, с пояснением их значения (комментарии приведены 

курсивным шрифтом). Еще раз обращаем внимание читателей на 
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имеющееся ограничение по длине строки в 80 символов. Например, 

если метка вместе со значением превышают длину в 80 символов, 

то метку размещают в одной строке, а значение в следующей. Если 

значение представлено в виде текста, также превышающего длину 

в 80 символов, то он делится по строкам, отвечающим данному кри-

терию. Также в .cif файле часто присутствуют пустые строки, ис-

пользуемые нарочно для визуального разделения некоторых блоков 

информации или абзацев текста. Все эти нюансы можно обнару-

жить в представленном ниже .cif файле. 

На основании информации из подобных .cif файлов в научных 

работах, содержащих описание новых структурных данных, 

должны быть представлены таблицы со сведениями о параметрах 

эксперимента и уточнения кристаллических структур. Пример та-

кой таблицы на русском и английском языках, составленной по дан-

ным из приведенного ниже .cif файла, показан в параграфе 

«Описание кристаллической структуры нового комплексного 

соединения уранила» главы 2. Кроме того, некоторая специальная 

информация из .cif файла в научных работах приводится в тексто-

вом виде в разделе, посвященном рентгеноструктурному экспери-

менту (указано в комментариях в примере .cif файла ниже). 
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Средства для проверки .cif файлов 

Наличие у .cif файла четкой структуры как у языка разметки 

текста дает возможность не только восприятия содержащихся в нем 

данных машиной, но и осуществления автоматической проверки 

правильности и целостности введенных в него данных. С учетом 

стремительно растущего количества отчетов о структуре кристал-

лов такая автоматическая проверка является крайней необходимо-

стью для контроля качества получаемых структурных данных. Хотя 

в большинстве случаев сегодня .cif файлы генерируются также ма-

шинами, все равно часть информации может вводиться в них вруч-

ную, могут быть некоторые неоднозначности в плане решения 

структуры, может отсутствовать необходимая информация и др. 

Международный союз кристаллографии разработал и поддержи-

вает такое средство автоматической проверки .cif файлов под назва-

нием checkCIF, которое доступно по ссылке https://checkcif.iucr.org/. 

Чтобы осуществить проверку, нужно загрузить в систему готовый 

.cif файл и получить отчет о проверке. 

В целом checkCIF сообщает о согласованности и целостности 

определений кристаллической структуры, представленных в фор-

мате CIF. Более конкретно текущая версия checkCIF включает сле-

дующие проверки: 

 

 синтаксис и структура CIF; 

 детали ячеек и геометрии; 

 симметрия пространственной группы; 

 параметры анизотропного смещения; 

 структурные факторы. 

 

https://checkcif.iucr.org/
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Отчет о проверке .cif файла может содержать предупреждения 

различных уровней: A, B, C и G [6]. Уровень предупреждения A ука-

зывает на то, что обнаружена потенциально серьезная проблема с 

данными. Уровень предупреждения B указывает на то, что обнару-

жена потенциальная проблема с данными. Его появление обычно 

указывает (в отдельности или вместе с другими предупреждениями) 

на то, что требуются некоторые корректирующие действия. Уро-

вень предупреждения C указывает на то, что обнаружено отклоне-

ние от установленных стандартов и, возможно, его необходимо 

исправить. Предупреждения уровня G в основном носят информа-

тивный характер, но ими не следует пренебрегать. Все предупре-

ждения должны быть проверены авторами: набор предупреждений 

более низкого уровня может в совокупности указывать на серьез-

ную проблему, которую необходимо решить. 

Следует учитывать, что предупреждения не обязательно явля-

ются ошибками. Они также могут указывать на интересные особен-

ности кристаллической структуры. В таком случае на имеющиеся 

предупреждения следует подготовить ответ прямо в .cif файле в 

специальной «форме ответа на проверку» (Validation Response Form 

или сокращенно VRF) – это часть текста в формате CIF, которая 

предоставляет возможность для ответа автора на имеющиеся пре-

дупреждения. Соответствующие метки в .cif файле имеют вид 

_vrf_test-name_datablock, где вместо ‘test-name’ указыва-

ется название теста, который привел к данному предупреждению 

(приводится в отчете о проверке), а вместо ‘datablock’ – название 

блока данных о кристаллической структуре, например, 

_vrf_PLAT213_1. На сегодняшний день многие редакции науч-

ных журналов требуют проведения проверки .cif файлов и предо-

ставления ответов на предупреждения уровней A и B при 

направлении для публикации научных статей, содержащих данные 

о новых кристаллических структурах. 
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Банки структурных данных и депонирование .cif файлов 

Для того, чтобы данные о новых кристаллических структурах 

собирались централизованно и были доступны исследователям, су-

ществуют различные банки структурных данных. При этом выде-

ляют основные и второстепенные кристаллографические банки 

структурных данных. Основные – это те, которые поддерживаются 

крупными организациями и представляют собой ценные ресурсы 

для науки в целом. Второстепенные же представляют собой акаде-

мические или небольшие банки данных, которые не поддержива-

ются на том же уровне долговечности или безопасности, который 

ожидается от основных банков данных. 

Самым объемным среди основных является «Кембриджский 

банк структурных данных» (Cambridge Structural Database или со-

кращенно CSD), содержащий данные о строении кристаллов орга-

нических соединений (порядка 1 250 000 структур в 2023 году). 

Вторым по размеру является «Банк данных неорганических кри-

сталлических структур» (Inorganic Crystal Structure Database или со-

кращенно ICSD), включающий данные о строении кристаллов 

неорганических соединений (порядка 300 000 структур в 2023 

году). Существуют также более узкоспециализированные банки 

структурных данных (как основные, так и второстепенные), содер-

жащие сведения о трехмерном строении белков (Protein Data Bank 

или сокращенно PDB, ≈ 200 000 записей в 2023 году), минералов 

(American Mineralogist Crystal Structure Database или сокращенно 

AMCSD, ≈ 4 300 записей в 2023 году), несоразмерно модулирован-

ных кристаллов (Bilbao Incommensurate Structures Database или со-

кращенно B-IncStrDB, ≈ 260 записей в 2023 году) и др. Более 

подробно с этими и другими банками структурных данных можно 

познакомиться на сайте Международного союза кристаллографии 

по ссылке https://www.iucr.org/resources/data/databases. 

https://www.iucr.org/resources/data/databases
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При публикации новых структурных данных авторам чаще 

всего необходимо самостоятельно загрузить соответствующие .cif 

файлы для всех новых кристаллов в подходящий банк структурных 

данных через интерфейс, предлагающийся данным банком – такой 

процесс называется депонированием кристаллических структур. 

В результате депонирования каждая структура получает уникаль-

ный идентификационный номер, по которому ее однозначно можно 

найти в соответствующем банке структурных данных. В банке дан-

ных CSD такой номер состоит из шести букв и при необходимости 

двух цифр (в случае родственных структур: полиморфные модифи-

кации, структуры одного кристалла при разных температурах и дав-

лении, повторные определения и др.) и называется рефкодом 

(refcode, например, KALHEN, QAXMEH60), а в банке данных 

ICSD – только из цифр и называется «кодом коллекции ICSD» 

(ICSD Collection Code, например, 183813). При упоминании банков 

структурных данных в научных работах следует указывать их 

названия и версии, а также приводить ссылки на публикации, по-

священные данными банкам. Обычно список рекомендуемых к ци-

тированию публикаций указывается на официальном сайте 

соответствующего банка структурных данных. Например, на теку-

щий момент при упоминании CSD в научных работах рекоменду-

ется цитирование работ [7, 8], а при упоминании ICSD – работы [9]. 

Компьютерное программное обеспечение 

для работы с .cif файлами 

Готовые .cif файлы можно либо просматривать напрямую и 

даже немного редактировать, либо открывать при помощи специа-

лизированных компьютерных программ для работы с кристалличе-

скими структурами. 
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Для просмотра .cif файлов напрямую можно использовать лю-

бые стандартные текстовые редакторы, такие как Notepad (Блок-

нот), WordPad, Word и др. При этом текстовый редактор Notepad 

(Блокнот), например, позволяет сохранять файл в исходном расши-

рении .cif, что, в свою очередь, означает, что при помощи этой ком-

пьютерной программы можно внести в .cif файл некоторую 

дополнительную информацию, как, например, цвет кристаллов, 

тривиальное название химического соединения, авторов соответ-

ствующей научной статьи и прочее. Тем не менее важно понимать, 

что таким образом вручную нельзя менять взаимозависимые дан-

ные, как, например, параметры ячейки, координаты атомов, пара-

метры анизотропного атомного смещения и др., т.к. при их 

изменении требуется переуточнение всей структуры целиком. 

Специализированные компьютерные программы для работы с 

кристаллическими структурами считывают всю информацию из .cif 

файла и позволяют работать с ней в интерактивном режиме. Одной 

из важных задач в этом контексте является отображение трехмер-

ной структуры кристалла с возможностью ее визуального анализа. 

Другой важной задачей является возможность кристаллохимиче-

ского анализа одной кристаллической структуры или выборки тако-

вых с целью поиска каких-либо фундаментальных закономерностей 

строения твердых тел. Эта задача подразумевает расчет координа-

ционных чисел атомов различными имеющимися методами, вклю-

чая метод пересекающихся сфер [10]; построение 

координационных полиэдров или полиэдров Вороного–Дирихле 

атомов [11]; расчет характеристик невалентных взаимодействий, 

включая межмолекулярные [12]; и многое другое. Среди таких спе-

циализированных компьютерных программ наиболее популярны 

Topos, Mercury, CrystalMaker, Vesta и Jmol, ключевые особенности 

некоторых из которых рассмотрены в главе 3.  
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ГЛАВА 2. ОСНОВНЫЕ ПОДХОДЫ К ОПИСАНИЮ 

КРИСТАЛЛИЧЕСКИХ СТРУКТУР 

Какую информацию необходимо привести 

для описания строения кристалла? 

Рассмотренный в предыдущей главе .cif файл содержит в себе 

всю информацию о строении кристалла. Однако, при описании 

строения кристаллов в письменном или устном виде следует при-

держиваться определенных правил, терминологии и приводить 

определенные характеристики. Рассмотрим далее какую информа-

цию необходимо указывать в научных работах при описании стро-

ения кристаллов различных типов. 

Каркасные кристаллы 

В качестве примера каркасного кристалла для рассмотрения 

выберем один из наиболее распространенных минералов титана – 

рутил, представляющий собой тетрагональную модификацию диок-

сида титана. 

В табл. 1 представлены данные, необходимые для описания 

кристаллической структуры рутила и рассмотренные далее более 

детально. Отметим, что в табл. 1 и в последующих таблицах в учеб-

ных целях значения различных величин представлены с некоторой 

«стандартной» точностью, которая достигается при использовании 

современного экспериментального оборудования. В научных же ра-

ботах значения таких величин следует приводить с учетом средне-

квадратичных отклонений, которые указаны в соответствующих .cif 

файлах, как это сделано в параграфе «Описание кристаллической 

структуры нового комплексного соединения уранила» главы 2. 
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Таблица 1. Кристаллоструктурная информация 

по каркасному кристаллу рутила 

Формула соединения TiO2 

Пространственная группа, Z, Z' P42/mnm, 2, 1 

R-фактор 0.0286 

Параметры элементарной ячейки 

a, b, Å 4.5937 

c, Å 2.9587 

α, β, γ, ° 90 

Координаты атомов 

Атомы Ti (0, 0, 0) 

Атомы O (0.30479, 0.30479, 0) 

Геометрические характеристики 

Координационное число Ti 6 

Координационное число О 3 

Координационный полиэдр Ti Октаэдр 

Координационный полиэдр О Плоский треугольник 

Кристаллохимическая формула TiO6/3 

d(Ti–O), Å 
1.9494 

1.9802 

(O–Ti–O), ° 

908 

81.22 

98.82 

Библиографические данные 

Код коллекции ICSD 23697 

Авторы S.C. Abrahams, J.L. Bernstein 

Журнал 

The Journal of Chemical Physics 

1971. V. 55. № 7. P. 3206. 

DOI: 10.1063/1.1676569 

 

Первое, на что обращает внимание любой химик – это состав и 

химическая формула вещества. В нашем примере рутил – это диок-

сид титана(IV) или TiO2. Химик неорганик на второе место по зна-

чимости после состава поставит химические свойства рутила, 
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однако для кристаллохимика куда более важна кристаллическая 

структура. Поэтому далее необходимо привести так называемую 

базовую кристаллоструктурную информацию: пространственную 

группу, параметры элементарной ячейки и координаты базисных 

атомов. Пространственная группа представляет собой совокуп-

ность всех элементов симметрии кристаллической структуры. Сим-

вол пространственной группы рутила записывается как P42/mnm. 

Напомним, что заглавной буквой в записи пространственной 

группы указывается символ решетки Бравэ, указывающий на си-

стему трансляций, которые формируют бесконечную кристалличе-

скую решетку. В нашем случае рутил описывается примитивной 

решеткой Бравэ P, что указывает на наличие целочисленных транс-

ляций a, b и с, а также их линейных комбинаций (a+b, a–c, 

a+b–c, …). После ячейки Бравэ приводится символ Германа–Мо-

гена или международный символ, представляющий собой запись 

симметрически не эквивалентных элементов симметрии. 

Параметры элементарной ячейки включают в себя величины 

координатных реперов a, b, c, а также величины углов между ними 

α, β и γ. Поскольку рутил кристаллизуется в тетрагональной синго-

нии величины координатных реперов a и b равны, а углы α, β и γ 

принимают значения 90° (табл. 1). Теперь, когда известны симмет-

рия, размер и форма элементарной ячейки, необходимо задать ко-

ординаты базисных атомов, которые взаимодействуя с элементами 

симметрии создадут трехмерно-периодическую кристаллическую 

структуру. Атомы титана в рутиле имеют координаты (0, 0, 0), т.е. 

располагаются в начале координат, занимая частную позицию с 

сайт-симметрией D2h. Атомы кислорода также располагаются в 

частной позиции с сайт-симметрией С2v и координатами (0.30479, 

0.30479, 0). 

После указания пространственной группы рутила необходимо 

привести число формульных единиц, обозначающееся буквой Z, ко-
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торое показывает какое число «молекул рутила» состава TiO2 (по-

тому что формула химического соединения в табл. 1 записана 

именно таким образом) находится в пределах одной элементарной 

ячейки. Кристаллическая структура рутила характеризуется вели-

чиной Z = 2. Иногда, помимо величины Z, используют параметр Z', 

представляющий число формульных единиц, деленное на кратность 

общей правильной системы точек. Т.е. значение Z' напрямую пока-

зывает количество кристаллографически независимых молекул 

того состава, который указан в формуле соединения, в соответству-

ющей кристаллической структуре. 

Любая расшифровка структуры, т.е. определение координат 

атомов, осуществляется с той или иной ошибкой, обусловленной 

качеством кристалла и несовершенством технического оборудова-

ния. Такая ошибка в кристаллографии называется фактор расходи-

мости и обозначается буквой R. Поскольку существует несколько 

вариантов расчета R-фактора, то важно отметить, что в таблицах, 

подобных табл. 1, указывается «классический» R-фактор, приводя-

щийся в метке _refine_ls_R_factor_gt в соответствующем 

.cif файле. Приемлемым значением R-фактора является величина, 

не превышающая 0.1 или 10%. Значение R-фактора меньше 5% го-

ворит о прецизионной съемке. Обратим внимание читателя, что 

указанные 10% являются пороговыми, если речь идет о низкомоле-

кулярных соединениях. В том случае если рассматривается кри-

сталл высокомолекулярного соединения, такого как белок, то 

величина R-фактора может достигать и 30%, при этом результат бу-

дет считаться приемлемым. Данный факт связан со сложностью 

съемки кристаллов высокомолекулярных соединений и их низкой 

степенью кристалличности. Кроме того, значение R-фактора может 

допустимо повышаться в случае наличия в структуре статистически 

разупорядоченных атомов, а также и некоторых других причин. Од-

нако в данном случае кристалл рутила характеризуется величиной 
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R-фактора 0.0286 или 2.86%, что указывает на высокое качество 

определения структуры. 

Приведенной выше информации достаточно для описания про-

странственного расположения атомов в веществе. Однако нас, как 

химиков, интересуют также и реализующиеся в структурах кри-

сталлов межатомные взаимодействия. Поэтому далее необходимо 

указать сколько химических связей образует каждый атом описыва-

емого соединения, находясь в кристаллической структуре. В рутиле 

атомы титана образуют шесть химических связей с атомами кисло-

рода, в то время как последние связаны с тремя атомами титана. 

Напомним, что количество химических связей, которые образует 

атом с другими атомами называется координационным числом 

(КЧ). Таким образом можно указать, что КЧ(Ti) = 6, а КЧ(O) = 3. Не 

менее важной характеристикой, чем КЧ, является координацион-

ный полиэдр (КП) – многогранник, в центре которого располага-

ется центральный атом, а в вершинах – атомы, химически 

связанные с центральным. В случае структуры рутила КП атомов Ti 

является октаэдр, а атомов О – плоский треугольник. Следует также 

указать способ сочленения координационных полиэдров металлов. 

В случае рутила КП атомов титана образуют ленты, за счет обоб-

ществления двух ребер. При этом сами ленты связаны друг с другом 

за счет общих вершин. 

Описание способа сочленения КП друг с другом удобно приво-

дить с помощью кристаллохимических формул. В общем виде кри-

сталлохимическая формула имеет вид: 

AXn/m, 

где А – центральный атом, X – атомы лигандов, n – КЧ атома А по 

отношению к атомам Х, m – КЧ атома Х по отношению к атомам А. 

В случае структуры рутила кристаллохимическая формула имеет 
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вид TiO6/3, из которой следует, что КЧ атомов титана равно 6, а ато-

мов кислорода – 3. При этом, кристаллохимическая формула легко 

переходит в обычную брутто-формулу, отвечающую диоксиду ти-

тана, путем математического деления TiO6/3 ≡ TiO2. 

Указав КЧ и КП атомов, необходимо привести длины химиче-

ских связей и величины валентных углов. Для рутила данная инфор-

мация показана в табл. 1. 

Немаловажной составляющей, которую необходимо привести 

для описания кристаллической структуры, является рисунок, изоб-

ражающий пространственное расположение атомов относительно 

друг друга. Чаще всего, особенно для каркасных кристаллов, 

удобно приводить иллюстрацию, на которой изображена элемен-

тарная ячейка (рис. 2). 

 

 

Рис. 2. Элементарная ячейка рутила TiO2 

 

 

Ti 

O 
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В том случае, если имеет место описание кристаллической 

структуры с точки зрения шаровых упаковок, необходимо такое 

описание также привести. Так, структуру рутила можно охаракте-

ризовать как двухслойную плотнейшую упаковку атомов кисло-

рода, в которой атомами титана заполнены половина 

октаэдрических пустот в каждом слое. 

Поскольку любая структура должна быть описана и опублико-

вана, то необходимо привести библиографические данные. Они 

включают в себя авторов публикации, название журнала, его том и 

номер, а также страница (или диапазон страниц), на которой пред-

ставлена публикация. Не лишним будет указать DOI и рефкод. 

Digital Object Identifier (DOI) – цифровой идентификатор объекта, 

представляет собой уникальный «номер» публикации, с помощью 

которого ее можно легко отыскать в цифровом виде в сети Интер-

нет. Рефкод – номер структуры в одном из банков кристаллострук-

турных данных (см. выше). 

Слоистые кристаллы 

Одним из примеров слоистого кристалла служит хлорид кад-

мия CdCl2, кристаллоструктурная информация о котором содер-

жится в табл. 2. 

Описание слоистого кристалла в целом похоже на описание 

каркаснопостроенного соединения. Точно так же необходимо при-

вести состав вещества, базовую кристаллоструктурную информа-

цию, данные об образующихся химических связях и другие 

сведения, приведенные в табл. 2. Отличие в описании слоистого 

кристалла заключается в том, что необходимо указывать как ориен-

тированы слои в пространстве. Для этого используются миллеров-

ские индексы (hkl), которые характеризуют расположение атомных 

плоскостей в кристалле. 
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Таблица 2. Кристаллоструктурная информация 

по слоистому кристаллу CdCl2 

Формула соединения CdCl2 

Пространственная группа, Z, Z' R3̅m, 3, 1 

R-фактор 0.0700 

Параметры элементарной ячейки 

a, b, Å 3.8459 

c, Å 17.4931 

α, β, ° 90 

γ, ° 120 

Координаты атомов 

Атомы Cd (0, 0, 0) 

Атомы Cl (0, 0, 0.25200) 

Геометрические характеристики 

Координационное число Cd 6 

Координационное число Cl 3 

Координационный полиэдр Cd Октаэдр 

Координационный полиэдр Cl Тригональный зонтичный 

Кристаллохимическая фор-

мула 
CdCl6/3 

d(Cd–Cl), Å 2.6376 

(Cl–Cd–Cl), ° 
93.66 

86.44 

Библиографические данные 

Код коллекции ICSD 86440 

Авторы D.E. Partin, M. O'Keeffe 

Журнал 

Journal of Solid State Chemistry 

1991. V. 95. № 1. P. 176. 

DOI: 

10.1016/0022-4596(91)90387-W 

 

В случае структуры CdCl2, слои распространяются парал-

лельно плоскости (001), поэтому при описании кристаллической 
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структуры CdCl2 следует привести рисунок, на котором будет изоб-

ражен бесконечный слой, располагающийся параллельно плоскости 

(001) – т.е. проекцию слоя на плоскость (001). Именно такая проек-

ция показана на рис. 3. 

Рис. 3. Бесконечный слой в структуре CdCl2. Показана проекция 

на плоскость (001) 

Как следует из рис. 3, КП кадмия представляет собой октаэдр. 

В пределах слоя каждый октаэдр CdCl6 связан с шестью точно та-

кими же октаэдрами CdCl6 благодаря обобществлению ребер. 

Атомы хлора образуют три химические связи с атомами кадмия и 

характеризуются КП в виде тригонального зонтичного полиэдра. 

Внимательный читатель уже обратил внимание, что кристалли-

ческие структуры рутила и хлорида кадмия характеризуются до-

вольно похожими кристаллохимическими формулами TiO6/3 и 

CdCl6/3, однако мотивы структур различны – рутил каркасный кри-

сталл, в то время как хлорид кадмия – слоистый. Более того, атомы 

металлов в обсуждаемых структурах TiO2 и CdCl2 образуют по 

Cl 
Cd 
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шесть связей с атомами неметаллов и характеризуются одинако-

выми КП – октаэдрами. Различия в октаэдрах TiO6 и CdCl6 проявля-

ются при рассмотрении длин химических связей. В случае 

октаэдров TiO6 величины d(Ti–O) не равноценны – атомы титана 

образуют 4 связи с атомами кислорода длиной 1.949 Å и две связи 

длиной 1.980 Å (табл. 1). В случае октаэдров CdCl6 все 6 длин связей 

Cd–Cl одинаковы и равны 2.637 Å (табл. 2). Также совпадают и КЧ 

атомов неметаллов в указанных структурах – атомы кислорода и 

атомы хлора связывают по три атома металла. Однако КП атомов 

неметаллов различны – в случае структуры рутила атомы кислорода 

лежат в плоскости, образованной тремя координированными ато-

мами титана, и характеризуются КП в виде плоского треугольника. 

В то же время, атомы хлора в структуре CdCl2 не лежат в плоскости, 

образованной тремя координированными атомами титана, а выхо-

дят из нее на величину 1.423 Å, формируя КП в виде тригонального 

зонтичного полиэдра. 

Обратим внимание, что в случае, когда две «похожие» на пер-

вый взгляд структуры существенно различаются в каком-либо па-

раметре, является полезным привести проекцию кристаллической 

структуры не только на одну какую-либо плоскость, а рассмотреть 

ее с разных сторон. На рис. 3 была приведена проекция слоя струк-

туры CdCl2 на плоскость (001), теперь рассмотрим проекцию кри-

сталлической структуры CdCl2 на плоскость (100), чтобы 

посмотреть на слои «с ребра». Такая проекция показана на рис. 4. 

С точки зрения плотнейших шаровых упаковок различие 

между структурами TiO2 и CdCl2 заключается в том, что в структуре 

рутила атомы титана занимают половину октаэдрических пустот в 

каждом плотноупакованном слое из атомов кислорода, в то время 

как в структуре CdCl2 заселенность октаэдрических пустот в плот-

ноупакованном слое из атомов хлора различается. А именно наблю-

дается чередование слоев с точки зрения их заселенности – в первом 
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слое заполнены все октаэдрические пустоты атомами кадмия, во 

втором – все октаэдрические пустоты вакантны, в третьем – снова 

все заняты атомами кадмия, в четвертом – снова все свободны. Та-

кая особенность в заселении октаэдрических пустот атомами кад-

мия обусловливает слоистость структуры хлорида кадмия. 

Рис. 4. Проекция кристаллической структуры CdCl2 на плоскость (100). 

Также показана элементарная ячейка 

Еще одним немаловажным параметром, который следует указы-

вать при описании любого слоистого кристалла, являются расстояния 

между соседними слоями. Из рис. 4 следует наличие трех кристалло-

графически неэквивалентных слоев, которые чередуются друг с дру-

гом, в случае структуры CdCl2. Тем не менее, расстояния между всеми 

парами соседних слоев одинаковые и имеют значение 5.831 Å. 

Цепочечные кристаллы 

Примером цепочечного кристалла, т.е. кристалла, содержащего 

бесконечно распространяющиеся химически связанные структур-

ные фрагменты в одном направлении, может служить структура 

Cd 

Cl 
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α-BeCl2. В табл. 3 приведены основные кристаллоструктурные  

параметры α-BeCl2. 

 

Таблица 3. Кристаллоструктурная информация  

по цепочечному кристаллу α-BeCl2 

Формула соединения BeCl2 

Пространственная группа, Z, Z' Ibam, 4, 1 

R-фактор 0.0270 

Параметры элементарной ячейки 

a, Å 5.2850 

b, Å 9.8070 

c, Å 5.2270 

α, ° 90 

β, ° 90 

γ, ° 90 

Координаты атомов 

Атомы Be (0, 0, 0.25) 

Атомы Cl (0.20700, 0.11171, 0) 

Геометрические характеристики 

Координационное число Be 4 

Координационное число Cl 2 

Координационный полиэдр Cd Тетраэдр 

Координационный полиэдр Cl Уголковый 

Кристаллохимическая формула BeCl4/2 

d(Be–Cl), Å 2.0264 

(Cl–Be–Cl), ° 
114.62 
99.72 
114.52 

Библиографические данные 

Код коллекции ICSD 86440 

Авторы С.И. Троянов 

Журнал 
Журнал неорганической химии 
2000. Т. 45. № 9. С. 1619. 
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Как и в случае каркасных или слоистых кристаллов, описание 

цепочечного кристалла включает в себя ту же необходимую инфор-

мацию, приведенную в табл. 3, а также некоторые дополнительные 

особенности, которые обсудим далее. 

Поскольку структура α-BeCl2 содержит бесконечные цепи, 

необходимо указать направление их распространения в структуре 

кристалла. Для этого, как и в случае слоистых кристаллов, оказыва-

ется удобно обозначить с помощью миллеровских индексов (hkl) 

плоскость, которая располагается перпендикулярно направлению 

цепочек. В случае структуры α-BeCl2, бесконечные цепи располага-

ются перпендикулярно плоскости (001). Поэтому при описании об-

суждаемой цепочечной структуры удобно привести проекцию на 

плоскость (001), как это показано на рис. 5. Также можно привести 

индекс узлового ряда [pqr], описывающий направление распростра-

нения цепочек в кристалле. В случае структуры α-BeCl2 данный уз-

ловой ряд имеет индекс [001]. 

Рис. 5. Проекция кристаллической структуры α-BeCl2  

на плоскость (001). Также показана элементарная ячейка 

Be 

Cl
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Немаловажным параметром цепочек является период повторя-

емости – трансляционный вектор, связывающий кристаллографиче-

ски-эквивалентные атомы. В случае структуры α-BeCl2 такой 

вектор соответствует трансляции с и равен 5.227 Å. 

Отметим, что в отличие от ранее рассмотренных структур, струк-

тура α-BeCl2 включает в себя тетраэдрически-координированные 

атомы металла, в то время как в структурах рутила и CdCl2, атомы ме-

талла образовывали по шесть химических связей. Таким образом, 

атомы бериллия образуют КП в виде тетраэдра, связанные друг с дру-

гом общими ребрами, в результате чего образуются ленты. 

Для цепочечных кристаллов следует также указывать расстоя-

ния между соседними цепочками. В структуре α-BeCl2 каждая Ве-

содержащая цепь окружена шестью другими Ве-содержащими це-

почками, что видно из рис. 5 (с учетом повторяемости элементарной 

ячейки). При этом две из них располагаются на расстоянии 5.285 Å 

и четыре – на расстоянии 5.570 Å. 

 

Молекулярные кристаллы 

Значительный объем кристаллов органических соединений 

представлен молекулярно-построенными кристаллами. Атомы, сла-

гающие ту или иную органическую молекулу, связаны друг с дру-

гом ковалентными связями, в то же время сами молекулы, 

упаковываясь в кристалл, проявляют друг по отношению к другу 

лишь слабые ван-дер-ваальсовы взаимодействия, а иногда и специ-

фические взаимодействия, такие как водородная связь, галогенная 

связь и др. Благодаря тому, что структура таких кристаллов осно-

вана на нескольких типах связей (по меньшей мере ковалентной и 

ван-дер-ваальсовой), такие кристаллы называют гетеродесмиче-

скими. 

В качестве примера, рассмотрим структуру бифенила, основная 

кристаллоструктурная информация по которому представлена в 
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табл. 4. Бифинил – органическое ковалентно построенное соедине-

ние. Формирование кристалла бифенила обусловлено проявлением 

между молекулами ван-дер-ваальсовых взаимодействий, а именно – 

дисперсионных сил. 

 

Таблица 4. Кристаллоструктурная информация 

по молекулярному кристаллу бифенила 

Формула соединения С12H10 

Пространственная группа, Z, Z' P21/c, 4, 1 

R-фактор 0.0230 

Параметры элементарной ячейки 

a, Å 9.4441 

b, Å 5.5793 

c, Å 7.8441 

α, γ, ° 90 

β, ° 94.08 

Координаты атомов 

Атомы C 

(0.42460, 0.50141, 0.46490) 

(0.32966, 0.32037, 0.50430) 

(0.18834, 0.32498, 0.43969) 

(0.13823, 0.50991, 0.33333) 

(0.23129, 0.68973, 0.29157) 

(0.37234, 0.68575, 0.35701) 

Атомы H 

(0.36493, 0.17416, 0.58717) 

(0.11675, 0.18454, 0.47470) 

(0.02804, 0.51379, 0.28522) 

(0.19521, 0.83356, 0.20675) 

(0.44251, 0.82910, 0.32240) 

Геометрические характеристики 

Координационное число C 3 

Координационное число H 1 

Координационный полиэдр C Плоский треугольник 

d(С–C), Å 1.388–1.490 

d(С–H), Å 1.081–1.085 
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От описания стандартных параметров, характерных для любых 

типов кристаллов и подробно рассмотренных выше на примере кар-

касного кристалла, перейдем сразу к особенностям описания строе-

ния молекулярных кристаллов. Поскольку структура бифенила – 

молекулярная, при ее описании нет необходимости приводить ка-

кие-то особенные проекции на ту или иную плоскость, как это де-

лается в случае слоистых и цепочечных кристаллов. В случае 

описания молекулярных кристаллов, можно приводить проекцию 

кристаллической структуры на любую плоскость – важным в этом 

случае является лишь информативность такой проекции. Например, 

на рис. 6 представлены проекции элементарной ячейки структуры 

бифенила на плоскости (100), (010) и (001). Как видно из рис. 6, 

наименее удачной проекцией элементарной ячейки структуры 

бифенила является проекция на плоскость (001), на которой моле-

кулы накладываются друг на друга (рис. 6в), затрудняя при этом 

восприятие строения кристалла. 

В случае молекулярно-построенных структур важным пара-

метром при описании является молекулярное координационное 

число – число молекул, окружающих данную в структуре кри-

сталла. Обратим внимание читателя, что атомное КЧ показывает 

число атомов, связанных с данным сильными химическими взаимо-

действиями, в то время как молекулярное КЧ характеризует число 

Окончание табл. 4 
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молекул, связанных с данной слабыми ван-дер-ваальсовыми взаи-

модействиями. В случае рассматриваемой структуры бифенила мо-

лекулярное КЧ равно 14. 

(а) 

(б) 

(в) 

Рис. 6. Проекции элементарной ячейки кристаллической  

структуры бифенила на плоскости (100) (а), (010) (б) и (001) (в) 

C 

H 
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Кристаллы координационных соединений 

Круг слоистых кристаллов не ограничивается только такими 

случаями, когда в пределах слоев между атомами реализуются  

химические связи, а сами слои связаны друг с другом слабыми ван-

дер-ваальсовыми взаимодействиями. Часто к слоистым кристаллам 

относят и такие кристаллы, структуры которых содержат слои из 

ковалентносвязанных атомов, в то время как между слоями  

располагаются положительно- или отрицательно-заряженные ионы, 

связывающие слои друг с другом посредством реализации ионных 

взаимодействий. Примерами таких кристаллов являются координа-

ционные соединения, в частности, тетрафтороникелат калия 

K2NiF4, основная структурная информация о котором представлена 

в табл. 5. 

 

Таблица 5. Кристаллоструктурная информация  

по кристаллу координационного соединения K2NiF4 

Формула соединения K2NiF4 

Пространственная группа, Z, Z' I4/mmm, 2,1 

R-фактор 0.0223 

Параметры элементарной ячейки 

a, b, Å 4.0120 

c, Å 13.0760 

α, β, γ, ° 90 

Координаты атомов 

Атомы K (0, 0, 0.35390) 

Атомы Ni (0, 0, 0) 

Атомы F 
(0, 0, 0,15300) 

(0.5, 0, 0) 

Геометрические характеристики 

Координационное число K 9 

Координационное число Ni 6 

Координационное число F 6 
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Окончание табл. 5 

Координационный полиэдр K 
Одношапочная квадратная  

антипризма 

Координационный полиэдр Ni Октаэдр 

Координационный полиэдр F Октаэдр 

Кристаллохимическая формула 

слоя 
NiF4/2F2/1 

d(Ni–F), Å 
2.0012 

2.0066 

d(K–F), Å 

2.627 

2.7704 

2.8384 

Библиографические данные 

Код коллекции ICSD 33520 

Авторы D. Babel, E. Herdtweck 

Журнал 

Zeitschrift fur Anorganische und 
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1982. V. 487. № 1. P. 75. 
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10.1002/zaac.19824870108 

 

Структура K2NiF4, на первый взгляд, может показаться каркас-

ной, поскольку все атомы, слагающие ее, связаны сильными взаи-

модействиями друг с другом в трехмерный каркас, как это показано 

на рис. 7. 

Однако более детальный анализ обсуждаемой структуры пока-

зывает, что кристалл K2NiF4 можно рассматривать в качестве слои-

стого. Для выделения слоев в структуре K2NiF4 необходимо учесть, 

что атомы фтора и никеля связаны друг с другом по большей мере 

ковалентными взаимодействиями – связь Ni–F является ковалент-

ной полярной связью, образованной по донорно-акцепторному ме-

ханизму между ионами Ni2+ и F–. В то же время атомы калия 

связаны с атомами фтора ярко выраженными ионными взаимодей-
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ствиями, в пользу чего говорит существенная разница в электроот-

рицательности атомов калия (0.82 по Полингу) и фтора (3.98 по По-

лингу), а также достаточно высокое координационное число атомов 

калия – девять. В результате этого данный кристалл является гете-

родесмическим, т.е. построенным на нескольких типах химической 

связи (в данном случае ионной и ионно-ковалентной). 

 

 

Рис. 7. Фрагмент структуры K2NiF4,  

соответствующий одной элементарной ячейке 

 

Данный факт позволяет рассматривать кристалл в качестве сло-

истого, в котором каждый ковалентно-связанный слой представлен 

октаэдрами NiF6, сочлененными друг с другом общими вершинами 

посредством общих атомов фтора, располагающихся в экваториаль-

ных позициях КП атомов никеля. При этом роль катионов калия за-

ключается в ионном связывании отрицательно заряженных 

никельсодержащих слоев друг с другом в трехмерный каркас. Рас-

стояние между слоями отвечает половине трансляции с, что соот-

ветствует величине 6.538 Å. 

При рассмотрении отдельных никельсодержащих слоев стано-

вится видна различная кристаллоструктурная роль двух кристалло-

графически неэквивалентных атомов фтора. Несмотря на то, что 

атомы F(1) и F(2) имеют одинаковое КЧ 6, атомы F(1) образуют 

K Ni 
F 
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одну связь с атомом никеля и пять связей с атомами калия, в то 

время как атомы F(2) реализуют две связи с атомами никеля и че-

тыре связи с атомами калия. Благодаря этому, никельсодержащие 

слои могут быть описаны следующей кристаллохимической форму-

лой NiF4/2F2/1, которая указывает на наличие двух принципиально 

разных атомов фтора по отношению к атомам никеля – одна поло-

вина атомов фтора по отношению к атомам никеля играет роль мо-

стиковых лигандов, в то время как оставшиеся атомы фтора по 

отношению к атомам никеля являются концевыми. Обсуждаемые 

слои распространяются параллельно плоскости (001), как это пока-

зано на рис. 8. 

 

 

Рис. 8. Проекция ковалентно-связанного слоя из октаэдров NiF6 

в кристалле K2NiF4 на плоскость (001) 

 

Также оказывается не лишним краткое описание КП атомов 

внешнесферных катионов. Как указано в табл. 5, атомы калия обра-

зуют 9 связей К–F, при этом девять атомов фтора окружают каждый 

атом калия по вершинам одношапочной квадратной антипризмы. 

F Ni 
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Следует отметить, что, рассуждая аналогичным образом, в ге-

теродесмических структурах можно выделять не только кова-

лентно-построенные слои, но и ковалентно-построенные цепочки, 

как, например, в структуре KPO3. Условно, соединение KPO3 можно 

рассматривать как координационно-построенное – роль централь-

ного атома играет атом фосфора, который координирует атомы кис-

лорода, в то время как ионы калия являются внешнесферными 

противоионами. При таком рассмотрении атомы фосфора и кисло-

рода связаны между собой полярными ковалентными связями с 

формированием бесконечных цепей, а ионы калия участвуют в 

электростатических взаимодействиях с такими цепями, связывая их 

в трехмерный каркас. Таким образом, структуру KPO3 можно опи-

сывать как цепочечную подобно тому, как было показано выше. 

В том случае, если описывается координационное соединение, 

содержащее лиганд, в котором имеется больше одного донорного 

атома, необходимо указать дентатность такого лиганда и привести 

более развернутую кристаллохимическую формулу, нежели в 

предыдущих примерах. Для этого рассмотрим структуру карбоната 

уранила UO2CO3 (рефкод 27053), которая представляет собой слои-

стый кристалл, в котором слои распространяются параллельно 

плоскости (010). Обратим внимание читателя на многоатомный ли-

ганд – карбонат-анион, который, обладая тремя атомами кислорода, 

потенциально может выступать в качестве тридентатного лиганда. 

Напомним, что дентатность показывает число донорных атомов ли-

ганда, которые образуют химические связи с атомами комплексо-

образователями. В случае структуры карбоната уранила все три 

донорных атома кислорода карбонат-аниона участвуют в связыва-

нии атомов урана. При этом, каждый из атомов кислорода образует 

по две связи с атомами урана, однако это не означает, что в целом 

карбонат-анион координируется шестью атомами урана. На рис. 9 

показан фрагмент кристаллической структуры карбоната уранила, 
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из которого видно, что атомы кислорода карбонат-иона имеют раз-

личную кристаллоструктурную роль. 

Рис. 9. Связывание атомов урана карбонат-анионом 

в структуре UO2CO3 с рефкодом 27053 

Особенности координации тех или иных лигандов выражаются 

в кристаллохимических формулах, подробно о которых читатель 

может узнать в научных статьях [13, 14]. В случае обсуждаемой 

структуры карбоната уранила, ионы CO3
2– обладают типом коорди-

нации T22–44, что указывает на тридентатность лиганда (буква Т), а 

также на то, что карбонат-ион связывает два атома монодентатно- 

(первая «2» в индексе) и два атома бидентатно (вторая «2» в ин-

дексе). Две «4» после тире означают, что в результате такой коор-

динации образуются два четырехчленных цикла. 

Следует отметить, что понятие дентатность чаще всего приме-

няется по отношению к σ-донорным лигандам, т.е. лигандам, обра-

зующим связь с центральным атомом-комплексообразователем за 

счет неподеленной электронной пары, располагающейся на несвя-

зывающей орбитали. Однако имеется целый класс соединений, 

представленный преимущественно металлоорганическими соеди-

нениями, в которых лиганд образует связь с атомом металла-ком-

плексообразователя за счет π-электронной плотности, заселяющей 

связывающие орбитали в лиганде. Таким образом, в обсуждаемом 

случае металл-комплексообразователь образует связь с лигандом 

посредством взаимодействия с электронной плотностью не одного 

U 

C O 
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конкретного атома, что приводит к некорректному использованию 

термина дентатность, – и в этом случае правильнее использовать 

понятие гаптичности. Гаптичность – число р-орбиталей, образую-

щих сопряженную π-электронную систему и участвующих в связы-

вании с атомом комплексообразователем. Классическим примером 

структуры, содержащей дигаптолиганд (т.е. лиганд, связанный с 

центральным атомом за счет двух сопряженных р-орбиталей) явля-

ется соль Цейзе – моногидрат трихлоро(этилен)платината калия 

K[Pt(CH2=CH2)Cl3]·H2O, в котором атом платины координирует мо-

лекулу этилена за счет π-электронной плотности. 

 

Описание кристаллической структуры 

нового комплексного соединения уранила 

В данном параграфе приведены примеры «стандартного» опи-

сания кристаллических структур комплексных соединений, содер-

жащих ионы уранила UO2
2+. С учетом особенностей описания 

кристаллов различных типов, рассмотренных выше, данный пара-

граф можно рассматривать в качестве руководства к действию по-

сле того, как исследователю наконец-то удалось получить заветный 

.cif файл с информацией о трехмерной структуре нового комплекс-

ного соединения уранила. Приведенное здесь описание является 

примерно однотипным для всех научных работ: для курсовых и вы-

пускных квалификационных работ студентов, для магистерских, 

кандидатских и докторских диссертаций, для научных статей в 

международных журналах и др. 

Первое, что необходимо сделать, это заполнить таблицу с 

названием «Кристаллографические данные, параметры экспери-

мента и уточнения структуры». Примером такой таблицы на рус-

ском и английском языках, составленной на основе данных из 

приведенного в главе 1 .cif файла, является табл. 6. Также в этой 
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таблице приведены метки, из которых берется соответствующая ин-

формация в .cif файле, что позволяет использовать табл. 6 в каче-

стве шаблона для составления других таблиц с новыми 

структурными данными. 

 

Таблица 6. Пример таблицы с кристаллографическими данными,  

данными о параметрах эксперимента и уточнения кристаллической 

структуры (на русском и английском языках). В правом столбце таблицы 

также приведены метки, из которых берется соответствующая  

информация в .cif файле 

Химическая формула 

Chemical formula 

[UO2(C3H5COO)2(C12H10N2)2] 
_chemical_formula_structural 

Сингония, пространствен-

ная группа, Z, Z' * 

Crystal system, space 

group, Z, Z' * 

Триклинная, 𝑃1, 1, 0.5 

Triclinic, 𝑃1, 1, 0.5 
_space_group_crystal_system 

_space_group_name_H-M_alt 

_cell_formula_units_Z 

a, b, c, Å 

7.5075(12), 

9.1655(14), 

11.1631(17) 
_cell_length_a 

_cell_length_b 

_cell_length_c 

α, β, γ, ° 

96.608(3), 

91.184(3), 

99.148(3) 
_cell_angle_alpha 

_cell_angle_beta 

_cell_angle_gamma 

V, Å3 
752.7(2) 
_cell_volume 

Dx, г/см3 

Dx, g/cm3 

1.775 
_exptl_crystal_density_diffrn 

Излучение, λ, Å 
MoKα, 0.71073 
_diffrn_radiation_type 
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Radiation, λ, Å _diffrn_radiation_wavelength 

μ, мм–1 

μ, mm–1 

5.442 
_exptl_absorpt_coefficient_mu 

Температура, K 

Temperature, K 

120(2) 
_diffrn_ambient_temperature 

Размеры кристалла, мм 

Crystal size, mm 

0.24 × 0.19 × 0.11 
_exptl_crystal_size_max 

_exptl_crystal_size_mid 

_exptl_crystal_size_min 

F(000) 
390 
_exptl_crystal_F_000 

Тип сканирования 

Diffraction measurement 

method 

φ, ω 
_diffrn_measurement_method 

Учет поглощения, Tmin, 

Tmax 

Absorption correction, Tmin, 

Tmax 

multi-scan, 0.2654, 0.7461 
_exptl_absorpt_correction_type 

_exptl_absorpt_correction_T_min 

_exptl_absorpt_correction_T_max 

Диапазон θ, ° 

θ range, ° 

1.84–30.77 
_diffrn_reflns_theta_min 

_diffrn_reflns_theta_max 

Диапазон h, k, l 

h, k, l range 

–10 ≤ h ≤ 10,

–13 ≤ k ≤ 13,

–16 ≤ l ≤ 16
_diffrn_reflns_limit_h_min 

_diffrn_reflns_limit_h_max 

_diffrn_reflns_limit_k_min 

_diffrn_reflns_limit_k_max 

_diffrn_reflns_limit_l_min 

_diffrn_reflns_limit_l_max 

Количество отражений: 

измеренных/независ. (N1), 

Rint/с I > 2σ(I)** (N2) 

Reflections number: 

10156/4654, 

0.0540/4640 
_diffrn_reflns_number 

_reflns_number_total 

_diffrn_reflns_av_R_equivalents 

Продолжение табл. 6 
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collected/unique (N1), 

Rint/with I > 2σ(I)** (N2) 

_reflns_number_gt 

Метод уточнения 

Refinement technique 

полноматричный МНК по F2 

full-matrix least-squares method on F2 

_refine_ls_matrix_type 

_refine_ls_structure_factor_coef 

Количество уточненных 

параметров 

Parameters refined 

197 
_refine_ls_number_parameters 

Факторы недостоверности: 

Uncertainty values: 

wR2 по N1 

wR2 on N1 

0.0799 
_refine_ls_wR_factor_ref 

R1 по N2 

R1 on N2 

0.0358 
_refine_ls_R_factor_gt 

S (GOOF) 

1.036 
_refine_ls_restrained_S_all 

или, если первый не приведен, то: 

_refine_ls_goodness_of_fit_ref 

Параметр абсолютной 

структуры по Флэку [5] 

Flack absolute structure 

parameter [5] 

– 
(только для нецентросимметричных кристалли-

ческих структур) 

_refine_ls_abs_structure_Flack 

Δρmax/Δρmin, e/Å3 
3.528/–2.762 
_refine_diff_density_max 

_refine_diff_density_min 

* Значение Z' в .cif файле не приводится и рассчитывается самостоятельно.

** Пороговое значение интенсивности, обычно основанное на кратных значениях 

σ(I) и задающееся меткой _reflns_threshold_expression. Этот порог 

служит для выделения отражений со значительной интенсивностью, которые 

используются при расчете «классического» R-фактора, указываемого в метке 

_refine_ls_R_factor_gt. 

Окончание табл. 6 
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Помимо табличных данных, часть информации о проведенном 

рентгеноструктурном эксперименте предоставляется в виде текста 

в соответстующем разделе в научной работе. В том числе в этом 

разделе следует указать любую специальную информацию, которая 

в .cif файле также приведена в виде текста в соответствующих мет-

ках (указано в комментариях в примере .cif файла в главе 1). Чаще 

всего в этом разделе указывают название экспериментального обо-

рудования, методику измерений, примененное излучение, исполь-

зованное компьютерное программное обеспечение, метод 

расшифровки структуры, способ уточнения позиций атомов водо-

рода и др. (оформляется вместе со специалистом, проводившим 

рентгеноструктурный эксперимент). 

Следующим шагом в описании новой кристаллической струк-

туры, содержащей катионы уранила, является указание основных 

длин связей и валентных углов. Особенность координационных со-

единений уранила заключается в том, что лиганды координируются 

катионом UO2
2+ таким образом, чтобы располагаться в экваториаль-

ной плоскости. Аксиальные позиции координационного полиэдра 

атома U(VI), представленного как правило n-гональной бипирами-

дой, занимают атомы кислорода диоксокатиона. Так, в случае 

структуры β-Cs3UO2(NCS)5 КП атома урана представляет собой 

пентагональную бипирамиду UO2N5 с атомами кислорода в акси-

альных позициях (рис. 10). Необходимо привести значения длин 

связей d(U=O), d(U–N) и величин валентных углов. Пентагональная 

бипирамида характеризуется 15 различными углами между ее вер-

шинами и центром, в котором располагается атом урана. Однако все 

эти углы приводить не следует, т.к. большинство из них окажется 

равными друг другу вследствие тех или иных симметрических пре-

образований. Обязательно необходимо указать угол O=U=O, кото-

рый характеризует линейность или нелинейность ионов уранила, а 

также углы, в образовании которых участвуют кристаллографиче-

ски независимые атомы, располагающиеся в экваториальной плос-

кости КП атома урана (табл. 7). 
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Рис. 10. Пентагонально-бипирамидальная координация атома урана  

в структуре β-Cs3UO2(NCS)5 

 

Таблица 7. Основные длины связей d и валентные углы ω 

в структуре β-Cs3UO2(NCS)5 

Пентагональная бипирамида UO2N5 

Связь d, Å Угол ω 

U(1)–O(1) 1.753(6) O(1)U(1)O(2) 177.3(3) 

U(1)–O(2) 1.756(6) N(1)U(1)N(2) 74.06(15)2 

U(1)–N(1) 2.412(8) N(2)U(1)N(3) 71.1(2)2 

U(1)–N(2) 2.440(6)2 N(3)U(1)N(3) 69.7(3) 

U(1)–N(3) 2.459(6)2   

Тиоцианат-ионы 

N(1)–C(1) 1.161(12) N(1)C(1)S(1) 178.2(9) 

C(1)–S(1) 1.616(11) N(2)C(1)S(2) 178.5(7) 

N(2)–C(2) 1.145(8) N(3)C(1)S(3) 179.5(8) 

C(2)–S(2) 1.602(7)   

N(3)–C(3) 1.168(9)   

C(3)–S(3) 1.620(9)   

 

Также целесообразно приводить геометрические параметры ли-

гандов, которые координируют катионы уранила. Вся необходимая 

информация содержится в .cif файле в соответствующих метках в цик-

U(1

О(1

О(2) 

N(1) 

N(2) 

N(2) 

N(3) 

N(3) 
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лах (loop_), посвященных длинам связей и значениям валентных уг-

лов (см. пример .cif файла в главе 1). В качестве примера в табл. 7 такая 

информация приведена для структуры β-Cs3UO2(NCS)5. 

Далее нужно оценить размерность структуры (молекулярная, це-

почечная, слоистая или каркасная) и привести в описании специфиче-

скую для данного типа структуры информацию (как указано в 

соответствующих параграфах выше). Следует отметить, что связыва-

ние отдельных фрагментов кристаллической структуры (слоев, цепей, 

островных группировок) в трехмерный каркас может осуществляться 

не только с помощью электростатических взаимодействий с внешне-

сферными катионами, но и с помощью реализации системы водород-

ных связей, галогенных связей или других типов взаимодействий.  

В этом случае необходимо привести отдельную таблицу, в которой бу-

дут указаны основные характеристики таких взаимодействий. Напри-

мер, в структуре (NH4)3[UO2(CH3COO)3]2[UO2(CH3COO)(NCS)2(H2O)] 

в образовании водородных связей участвуют атомы водорода внутри-

сферной молекулы воды и атомы водорода внешнесферного катиона 

аммония, и необходимо привести в отдельной таблице параметры та-

ких водородных связей (табл. 8, рис. 11). 

 

Таблица 8. Параметры водородных связей в структуре 

(NH4)3[UO2(CH3COO)3]2[UO2(CH3COO)(NCS)2(H2O)] 

D–H···A 
Расстояния, Å Угол 

D–H···A, 

° D···A D–H H···A 

O(10)–H(1)···S(1) 2.647(4) 0.81(4) 1.84(4) 177(6) 

N(3)–H(14)···S(1) 3.772(5) 0.90(6) 2.91(6) 160(4) 

N(3)–H(15)···O(3) 2.813(5) 0.92(5) 1.93(5) 161(5) 

N(3)–H(16)···O(11) 2.813(5) 0.93(5) 1.89(6) 174(5) 

N(3)–H(17)···O(9) 2.829(5) 0.925(19) 2.13(4) 131(4) 
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Рис. 11. Водородные связи в структуре 

(NH4)3[UO2(CH3COO)3]2[UO2(CH3COO)(NCS)2(H2O)] 

с участием катионов аммония 

При описании водородных связей рассматриваются фрагменты 

D–H···A, где H – положительно поляризованный атом водорода, 

D – донор водородной связи (химически связан с атомом водорода), 

А – акцептор водородной связи (электроотрицательный атом, кото-

рый предоставляет электронную плотность положительно поляри-

зованному атому водорода). На примере структуры 

(NH4)3[UO2(CH3COO)3]2[UO2(CH3COO)(NCS)2(H2O)] в табл. 8 пред-

ставлены основные геометрические характеристики водородных 

связей, которые необходимо указать при описании кристалличе-

ской структуры. В некоторых случаях соответствующая информа-

ция может быть представлена в .cif файле в цикле (loop_), 

U 

N C S 

O 
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посвященном водородным связям (соответствующие метки начина-

ются как _geom_hbond_, см. пример .cif файла в главе 1). Однако, 

даже в случае наличия этой информации в .cif файле, рекомендуется 

самостоятельный анализ водородных связей в специализированных 

компьютерных программах и при помощи универсальных методов 

анализа невалентных взаимодействий, например, при помощи по-

строения полиэдров Вороного–Дирихле и компьютерного про-

граммного обеспечения Topos. Также желательно приведение 

классификации обнаруженных водородных связей по силе (слабые, 

средние, сильные) в соответствии с систематикой, представленной 

в работе [15]. 

Напоследок, при описании строения нового комплексного со-

единения уранила необходимо привести изображения фрагментов 

структуры, демонстрирующие ее ключевые особенности в подходя-

щих ракурсах. В некоторых случаях, например, в некоторых науч-

ных журналах, требуется приведение так называемых ORTEP 

изображений структур, на которых атомы отрисовываются в виде 

отвечающих им тепловых эллипсоидов. Однако, такие изображения 

часто можно приводить не в основном тексте статьи, а в дополни-

тельной информации, которая публикуется в электронном виде на 

сайте журнала и, в отличие от статьи, может иметь любой объем.  

В дополнительную информацию также можно помещать и некото-

рые таблицы и другую информацию, которые в явном виде не об-

суждаются в основном тексте статьи. 
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ГЛАВА 3. СПЕЦИАЛИЗИРОВАННЫЕ КОМПЬЮТЕРНЫЕ 

ПРОГРАММЫ ДЛЯ РАБОТЫ С .CIF ФАЙЛАМИ 

Очень важное преимущество оформления кристаллографиче-

ской информации при помощи языка разметки текста заключается 

в том, что она в таком виде может читаться не только человеком, 

но и машиной, которая позволяет вывести кристаллохимический 

анализ на более глубокий уровень. Для работы с кристаллическими 

структурами существует большое количество специализированных 

компьютерных программ, среди которых наибольшей популярно-

стью пользуются Topos, Mercury, CrystalMaker и Vesta. Также суще-

ствует компьютерная программа Jmol, которая хоть и может 

использоваться автономно как и другие перечисленные программы, 

но более известна в виде JSmol, являющегося интерактивным объ-

ектом веб-браузера, т.е. позволяет представлять трехмерные враща-

емые модели кристаллических структур прямо на страницах 

веб-сайтов. 

Далее поочередно рассмотрим компьютерные программы 

Topos, Mercury, CrystalMaker и Vesta в отдельности с приведением 

необходимого минимума информации для начала работы, с указа-

нием ключевых особенностей каждой из них и с описанием возмож-

ностей экспорта изображений (включая полиэдрическое 

представление, ORTEP изображения, отрисовку огранки кри-

сталла), видео анимаций и 3D моделей для использования в каче-

стве рисунков в научных работах, в материалах презентаций и для 

3D печати. 
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Topos 

 

Описание компьютерной программы и ключевые особенности 

Компьютерная программа Topos была разработана на кафедре 

неорганической химии Самарского университета. Основная ее осо-

бенность заключается в том, что в ней реализована идея стереоатом-

ной модели строения кристаллов [11], в которой любой атом 

рассматривается как мягкая легко деформируемая сфера фиксиро-

ванного объема. Кристаллохимический анализ здесь осуществляется 

в рамках разбиения пространства с помощью полиэдров Вороного–

Дирихле. Координационные числа атомов рассчитываются по ме-

тоду пересекающихся сфер или секторов, что позволяет выявлять 

наличие химических, специфических и других ван-дер-ваальсовых 

взаимодействий однозначно и точно [10]. Все это практически без-

гранично расширяет возможности разностороннего анализа кристал-

лических структур в компьютерной программе Topos. 

Условия использования компьютерной программы 

Компьютерная программа Topos предоставляется для неком-

мерческого использования бесплатно. 

Ссылка на компьютерную программу для приведения в научных 

работах 

В случае использования компьютерной программы Topos при 

оформлении научных работ необходимо указание ссылки: на рус-

ском языке ссылки [16], на английском языке ссылки [17]. 

Импорт структурных данных, просмотр основной кристалло-

графической информации и изменение стиля отображения струк-

тур 

Чтобы импортировать структуру в Topos, необходимо запу-

стить компьютерную программу и выполнить команду Database → 
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Import. Далее необходимо выбрать анализируемый .cif файл струк-

туры. Компьютерная программа далее попросит ввести название 

для новой базы структурных данных, в которую поместит импорти-

руемую структуру (также можно выбрать уже существующую базу 

структурных данных для добавления в нее). Затем компьютерная 

программа попросит сначала подтвердить создание новой базы, по-

сле чего будет необходимо ввести код доступа. Код доступа можно 

применять для защиты информации, но по умолчанию следует ис-

пользовать код доступа «1». После этого откроется окно выбранной 

базы структурных данных с записью, отвечающей новому импорти-

рованному соединению. 

Чтобы посмотреть основные характеристики структуры, необ-

ходимо открыть карточку соединения двойным щелчком мыши по 

интересующей записи. Чтобы изобразить кристаллическую струк-

туру соединения необходимо его выбрать щелчком мыши и выпол-

нить команду Program → IsoCryst. В открывшемся окне необходимо 

в верхней панели инструментов нажать на символ карандаша, после 

чего появится изображение элементарной ячейки соединения в про-

екции на плоскость (001). Изменение стиля изображения возможно 

как при помощи многочисленных инструментов на нижней панели, 

так и в опциях IsoCryst (иконка с изображением восклицательного 

знака голубого цвета в верхней панели инструментов). Имеется воз-

можность отрисовки координационных полиэдров и полиэдров Во-

роного–Дирихле. Возможностей подготовки ORTEP изображений и 

отрисовки огранки кристаллов не предусмотрено. 

Инструменты для отображения необходимого фрагмента 

структуры 

Для отображения необходимого фрагмента структуры можно 

либо при помощи мыши и различных инструментов выделения вы-

делять и удалять ненужные атомы, либо, наоборот, «достраивать» 

структуру по валентным и/или невалентным связям при помощи 



71 

крайне удобной кнопки с иконкой зеленого росточка (рис. 12). При 

этом выбор типов связей, по которым осуществляется рост струк-

туры и которые необходимо отображать/скрывать, осуществляется 

в опциях компьютерной подпрограммы IsoCryst. 

Рис. 12. Фрагмент цепочечного кристалла 

в компьютерной программе Topos 

Экспорт изображений, видео анимаций, 3D моделей 

Для экспорта изображений в компьютерной программе Topos 

имеется только одна команда Image → Copy, при выполнении кото-

рой в буфер обмена попадает изображенный на экране фрагмент 

структуры в разрешении, соответсвующем разрешению экрана мо-

нитора. Такое изображение можно в дальнейшем использовать в 

неизменном виде или обрабатывать в стороннем компьютерном 
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программном обеспечении. Экспортировать векторные изображе-

ния, видео анимации или файлы 3D моделей структур в компьютер-

ной программе Topos невозможно. 

Mercury 

Официальный сайт компьютерной программы 

https://www.ccdc.cam.ac.uk/solutions/software/mercury/ 

Описание компьютерной программы и ключевые особенности 

Mercury позволяет визуализировать кристаллические струк-

туры, проводить анализ структурных данных. Позволяет генериро-

вать растровые изображения высокого разрешения (при помощи 

POV-Ray), видео анимации и 3D модели. Также в Mercury реализо-

вана возможность экспорта файлов в специальном формате, подхо-

дящем для 3D печати фрагментов структур. Mercury позволяет 

отображать элементы симметрии пространственной группы кри-

сталла, что очень удобно как при анализе строения кристаллов, так 

и при изучении основ кристаллохимии и других смежных дисци-

плин. 

Кроме того, Mercury включает в себя множество встроенных 

инструментов для анализа структурных данных, постоянно дораба-

тываемых и пополняемых, включая, например, возможность рас-

чета теоретических порошковых рентгенограмм и анализ 

склонности химических соединений к образованию водородных 

связей. Ну и одна из самых ключевых особенностей Mercury заклю-

чается в том, что она разрабатывается и поддерживается той же ор-

ганизацией Cambridge Crystallographic Data Centre (CCDC), что и 

«Кембриджский банк структурных данных» (CSD). По сути компь-

https://www.ccdc.cam.ac.uk/solutions/software/mercury/
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ютерная программа Mercury поставляется вместе с CSD и интегри-

рована в него, что косвенно подразумевает далекие перспективы 

компьютерной программы Mercury. 

Условия использования компьютерной программы 

Основной набор функций компьютерной программы Mercury 

является бесплатным для пользователей, но определенные специ-

альные возможности становятся доступными только при приобре-

тении лицензии на использование. Кафедра неорганической химии 

Самарского университета такой лицензией обладает. 

Ссылка на компьютерную программу для приведения в научных 

работах 

В случае использования компьютерной программы Mercury 

при оформлении научных работ необходимо указание ссылки. На 

официальном сайте компьютерной программы Mercury на момент 

издания данного учебного пособия рекомендуется использование 

ссылки [18]. 

Импорт структурных данных, просмотр основной кристалло-

графической информации и изменение стиля отображения струк-

тур 

Чтобы начать работу с кристаллической структурой в Mercury, 

нужно открыть компьютерную программу и при помощи команды 

File → Open… открыть интересующий .cif файл. На экране отобра-

зятся полные (не осколочные) фрагменты структуры, распознанные 

компьютерной программой (рис. 13). При необходимости можно 

отобразить либо асимметричную часть элементарной ячейки, либо 

упаковку фрагментов структуры, при которой показывается вся эле-

ментарная ячейка с дополненными фрагментами (соответствующие 

кнопки внизу страницы). Основные кристаллографические характе-

ристики можно посмотреть при нажатии на кнопку ‘More Info’. В 
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Mercury есть несколько удобных подготовленных стилей отображе-

ния структур для печатных публикаций, презентаций, 3D печати и 

др., но имеется и возможность самостоятельного выбора различных 

характеристик отображения атомов и связей, таких как цвет, раз-

мер, тип и др. Имеется возможность подготовки ORTEP изображе-

ний, отрисовки координационных полиэдров и огранки кристаллов. 

Возможностей отрисовки полиэдров Вороного–Дирихле не преду-

смотрено. 

Рис. 13. Фрагмент кристаллической структуры 

в компьютерной программе Mercury 

Инструменты для отображения необходимого фрагмента 

структуры 

Чтобы изобразить необходимый фрагмент структуры удобно 

либо начать с отображения упаковки и потом при помощи мыши 
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удалять/прятать ненужные атомы/молекулы, либо начать с мини-

мального фрагмента, например, изображения асимметричной части 

элементарной ячейки, и использовать удобный инструмент Picking 

Mode → Reveal Symmetry Generated Molecules, отображающий сим-

метрийно-зависимые атомы/молекулы в позициях, по которым осу-

ществляется нажатие мышью. Также для полимерных структур 

удобной является функция Edit → Polymer Expansion, позволяющая 

с каждым нажатием «выращивать» следующие «слои» атомов отно-

сительно имеющегося фрагмента. 

Экспорт изображений, видео анимаций, 3D моделей 

Чтобы экспортировать изображение структуры необходимо 

выполнить команду File → Save As… и выбрать в качестве формата, 

например, PNG изображение. При таком выборе появится диалого-

вое окно, позволяющее задать разрешение итогового изображения 

и прозрачность фона. Кроме того, можно воспользоваться командой 

File → POV-Ray Image… В этом случае откроется диалоговое окно, 

в котором можно также задать необходимое разрешение файла, 

установить некоторые характеристики стиля отображения струк-

туры и даже сгенерировать кадры для последующего создания ани-

мации. Все сгенерированные файлы сохраняются в выбранную 

папку для последующей работы с ними (например, чтобы создать 

видео анимацию из сгенерированных файлов необходимо исполь-

зовать дополнительное компьютерное программное обеспечение). 

Для генерации файла для 3D печати модели структуры использу-

ется команда File → Print in 3D…, при выполнении которой откры-

вается диалоговое окно с возможностью выбора формата файла, 

размера модели и даже с возможностью автоматического генериро-

вания поддержек при наличии нависающих частей в модели при 

необходимости. Экспорт векторных изображений в Mercury на мо-

мент издания данного учебного пособия не предусмотрен. 
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CrystalMaker 

Официальный сайт компьютерной программы 

https://crystalmaker.com/ 

Описание компьютерной программы и ключевые особенности 

CrystalMaker является, вероятно, одной из самых распростра-

ненных, разрекламированных и мощных компьютерных программ 

для работы с кристаллическими структурами. Позволяет генериро-

вать изображения и анимации высокой четкости (в том числе век-

торные изображения), включая цветной 3D стерео режим, просмотр 

которого осуществляется в стереоочках для создания реалистич-

ного эффекта объемной структуры. Также имеет возможность экс-

порта файлов для 3D печати. 

Помимо визуализации CrystalMaker также обладает мощным 

функционалом по анализу структурных данных, включая возмож-

ность оптимизации структур по энергии, анализа порошковых рент-

генограмм, дифракционных картин монокристаллов со 

стереографическими проекциями, данных просвечивающей элек-

тронной микроскопии и др. (некоторые функции реализованы в 

родственных компьютерных программах, устанавливаемых от-

дельно). 

Условия использования компьютерной программы 

Использование компьютерной программы CrystalMaker воз-

можно только при приобретении одной из разнообразных лицензий, 

представленных на официальном сайте. Кафедра неорганической 

химии Самарского университета обладает лицензией на использо-

вание компьютерной программы CrystalMaker. 

https://crystalmaker.com/
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Ссылка на компьютерную программу для приведения в научных 

работах 

В случае использования компьютерной программы 

CrystalMaker при оформлении научных работ необходимо указание 

ссылки. На официальном сайте компьютерной программы 

CrystalMaker на момент издания данного учебного пособия реко-

мендуется использование ссылки [19]. 

Импорт структурных данных, просмотр основной кристалло-

графической информации и изменение стиля отображения струк-

тур 

Рис. 14. Элементарная ячейка кристалла  

в компьютерной программе CrystalMaker 

Чтобы приступить к анализу кристаллической структуры в 

компьютерной программе CrystalMaker, необходимо ее запустить и 
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выполнить команду File → Open… В открывшемся окне нужно вы-

брать интересующий .cif файл, после чего на экране отобразится 3D 

модель элементарной ячейки кристалла (см. рис. 14). Справа на 

экране отображается панель ‘Inspector’, в которой приведена основ-

ная кристаллографическая информация. Там же имеются широкие 

возможности по изменению стиля отображения структуры (раз-

меры и цвета атомов, связей и прочее). Имеется возможность под-

готовки ORTEP изображений, отрисовки координационных 

полиэдров и огранки кристаллов. Возможностей отрисовки полиэд-

ров Вороного–Дирихле не предусмотрено. 

Инструменты для отображения необходимого фрагмента 

структуры 

Для отображения необходимого фрагмента структуры можно 

использовать различные варианты функции ‘Range’, где так или 

иначе задаются граничные значения координат x, y и z, в пределах 

которых отображаются все атомы структуры. Также имеется функ-

ция ‘Cluster’, позволяющая выбрать центральный атом и радиус 

сферы относительно него, в пределах которой будут отображаться 

атомы структуры. Кроме того, имеется набор удобных функций 

‘Tidy’, включающий отображение только асимметричной части 

ячейки, одиночной молекулы, возможность достройки или удале-

ния неполных молекул и др. Окончательный выбор отображае-

мых/скрываемых атомов можно осуществлять при помощи мыши 

поштучно. 

Экспорт изображений, видео анимаций, 3D моделей 

При экспорте изображений по команде File → Export Graphics 

имеется возможность выбора либо пяти форматов растровой гра-

фики (TIFF, PNG, JPEG, BMP, GIF), либо формата XPS векторной 

графики. При выборе форматов растровой графики можно при по-

мощи ползунка ‘Magnification’ выбрать необходимый размер итого-

вого изображения, который отображается в поле ‘Output Size’. При 
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этом форматы XPS, TIFF и PNG допускают экспорт изображений с 

прозрачным фоном, что удобно для дальнейшего редактирования и 

создания многослойных изображений. 

При экспорте видео анимации (File → Export Video) открыва-

ется диалоговое окно с возможностью выбора оси вращения 

(Rotation Axis), количества кадров (Number of frames), продолжи-

тельности анимации (Duration). Также при помощи ползунка ‘Scale’ 

можно варьировать разрешение итогового видео файла. 

Для экспорта 3D моделей структуры, в том числе для 3D пе-

чати, следует использовать команду File → Export Graphics и выби-

рать форматы COLLADA или STL, являющиеся широко 

используемыми в 3D индустрии. 

Vesta 

Официальный сайт компьютерной программы 

https://jp-minerals.org/vesta/en/ 

Описание компьютерной программы и ключевые особенности 

Vesta в отличие от предыдущих компьютерных программ была 

создана несколькими энтузиастами и не обладает настолько же ши-

рокой поддержкой и темпами развития. Тем не менее, Vesta обла-

дает всем необходимым функционалом для визуализации 

кристаллических структур. В компьютерной программе реализо-

ваны достаточно большие возможности по выбору способа отри-

совки атомов, связей различных типов, полиэдров, что совместно с 

возможностью генерирования изображений с высоким разреше-

нием, включая векторные изображения, и интуитивно понятным 

https://jp-minerals.org/vesta/en/
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интерфейсом делает Vesta очень удобным и привлекательным ре-

сурсом для применения в учебной и научной деятельности для со-

здания красивых изображений кристаллов. Возможность экспорта 

3D моделей также предусмотрена, в том числе в форматах, пригод-

ных для 3D печати. 

Помимо отображения кристаллографических данных в Vesta 

реализована возможность отображения различных объемных дан-

ных при помощи изоповерхностей, таких как электронная плот-

ность и ядерная плотность. Также есть возможность расчета 

теоретической порошковой рентгенограммы. 

Условия использования компьютерной программы 

Компьютерная программа Vesta предоставляется для неком-

мерческого использования бесплатно. 

Ссылка на компьютерную программу для приведения в научных 

работах 

В случае использования компьютерной программы Vesta 

при оформлении научных работ необходимо указание ссылки. 

На официальном сайте компьютерной программы Vesta на момент 

издания данного учебного пособия рекомендуется использование 

ссылки [20]. 

Импорт структурных данных, просмотр основной кристалло-

графической информации и изменение стиля отображения струк-

тур 

Чтобы начать работу с кристаллической структурой, необхо-

димо запустить компьютерную программу Vesta, выполнить ко-

манду File → Open… и выбрать целевой .cif файл. На экране 

отобразится элементарная ячейка с дорисованными неполными 

(осколочными) фрагментами структуры (рис. 15). Чтобы посмот-

реть основную кристаллографическую информацию о структуре, 
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необходимо выполнить команду Edit → Edit Data. Слева от изобра-

жения структуры имеется панель инструментов, позволяющая 

весьма свободно менять стили отображаемых атомов и связей. Име-

ется возможность подготовки ORTEP изображений, отрисовки ко-

ординационных полиэдров и огранки кристаллов. Возможностей 

отрисовки полиэдров Вороного–Дирихле не предусмотрено. 

Рис. 15. Фрагмент кристаллической структуры 

в компьютерной программе Vesta 

Инструменты для отображения необходимого фрагмента 

структуры 

Чтобы отобразить на экране необходимый фрагмент структуры 

нужно пользоваться функцией ‘Boundary…’. В ней есть возмож-

ность установления диапазона координат x, y и z для отображения 
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атомов, а также использования плоскостей, задаваемых миллеров-

скими индексами (hkl) и «отрезающих» определенные части струк-

туры. Поштучно лишние атомы можно удалить при помощи 

выделения мышью двойным щелчком и нажатием клавиши ‘Delete’ 

на клавиатуре. 

Экспорт изображений, видео анимаций, 3D моделей 

Для экспорта растровых изображений имеется команда File → 

Export Raster Image…, позволяющая сохранить изображение в до-

статочно большом количестве разнообразных форматов. При этом 

будет возможность выбора значения параметра ‘Scale’, определяю-

щего разрешение итогового файла. Экспорт векторных изображе-

ний, например, в форматах EPS или SVG возможен по команде 

File → Export Vector Image… Экспорт 3D моделей возможен, напри-

мер, в формате VRML, широко применяемом в области 3D печати. 

Возможность экспорта видео анимаций в компьютерной программе 

Vesta не предусмотрена. 
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